Signals from the Deep

Focus
Technology for detecting oil in the deep sea: CTD (conductivity, temperature, depth profiler)

Grade Level
9-12 (Earth Science/Physical Science/Technology)

Focus Question
How does a CTD help detect oil in the deep ocean?

Learning Objectives
- Students will describe oceanographic parameters that can be used to detect submerged oil.
- Students will explain how oceanographers can use CTD data to measure these parameters.
- Students will analyze data from CTD casts in the Gulf of Mexico for signals that may indicate the presence of submerged oil.

Materials
- Copies of Introduction to CTD Data and How They May Detect Oil Worksheet, one copy for each student group

Audio/Visual Materials
- (Optional) Video projector or large screen monitor for showing downloaded images (see Learning Procedure, Step 3)

Teaching Time
One or two 45-minute class periods, plus time for student research

Seating Arrangement
Groups of 2-4 students
Lessons from the Deep: Exploring the Gulf of Mexico’s Deep-Sea Ecosystems
Reflections from the Deep - Grades 9-12 (Earth Science/Physical Science/Technology)

Maximum Number of Students
30

Key Words
CTD
Fluorescence
CDOM
Dissolved Oxygen
Optical backscatter
Plume
Oil

Background Information
Around 10:00 pm CDT on April 20, 2010, a gas explosion occurred on the mobile offshore drilling unit Deepwater Horizon about 40 miles southeast of the Louisiana coast. The explosion killed 11 workers, injured 17 others, ignited an intense fire that burned until the Deepwater Horizon sunk 36 hours later, and resulted in a massive release of crude oil that is now considered the greatest environmental disaster in U.S. history. The total volume of oil released into the Gulf of Mexico is estimated to have been 205 million gallons (4.9 million barrels), dwarfing the 11-million-gallon Exxon Valdez spill of 1989. Ecological impacts of the released oil have received extensive media attention, particularly those affecting beaches, marshes, birds, turtles, and marine mammals; but other, less visible, organisms may be affected as well. Many scientists are particularly concerned about the unusual and biologically-rich communities on the Gulf of Mexico seafloor.

In the weeks following the explosion and blowout, scientific investigations concerned with the Deepwater Horizon focused primarily on documenting the location, extent, and movement of released oil. Using specialized computer models that integrate information on currents and winds, NOAA oceanographers produced daily Oil Trajectory Maps that show the predicted movement of spilled oil on the water surface. These predictions also incorporate satellite imagery analysis and observations from trained observers who make helicopter overflights across potentially affected areas (for more information, see http://response.restoration.noaa.gov/book_shelf/1926_TrajectoryFieldGuide.pdf).

Investigations below the surface rely heavily on a standard instrument for oceanographic studies known as a CTD. CTD stands for conductivity, temperature, and depth, and refers to a package of electronic instruments that measure these properties. Conductivity is a measure of how well a solution conducts electricity and is directly related to salinity, which is the concentration of salt and...
other inorganic compounds in seawater. Salinity is one of the most basic measurements used by ocean scientists. When combined with temperature data, salinity measurements can be used to determine seawater density which is a primary driving force for major ocean currents. Often, CTDs are attached to a much larger metal frame called a rosette, which may hold water sampling bottles that are used to collect water at different depths, as well as other sensors that can measure additional physical or chemical properties.

One such property that is particularly important to Deepwater Horizon investigations is “colored dissolved organic matter (CDOM), typically measured with a sensor called a CDOM fluorometer. CDOM absorbs light, typically in the blue to ultraviolet range, which makes water appear greenish to yellow-green to brown (the color changes with increasing CDOM concentration). Oil is a type of CDOM. In addition to absorbing light, oil also is one of many substances that exhibit a property known as fluorescence. These substances emit some of the light they absorb. In most cases, the emitted light has a longer wavelength (lower energy) than the absorbed light. CDOM fluorometers typically expose test materials to ultraviolet light (wavelength ranges from 300 - 400 nm), then measure the intensity of light emitted by the materials being tested. Oils typically fluoresce in the visible wavelength range from 400-600 nm. This range includes wavelengths that human eyes perceive as violet, blue, green, and yellow. CDOM fluorometers are calibrated so that the intensity of fluorescence can be related to the concentration of CDOM (which is usually in micrograms per liter, which is equal to milligrams per cubic meter or parts per billion). In addition to the CDOM fluorometer, CTD packages used for studying the Deepwater Horizon blowout often include sensors for measuring optical backscatter and dissolved oxygen. Optical backscatter (OBS) sensors detect the presence of suspended particles.

In early May, scientists working about 5 nautical miles from the blowout site discovered several layers in the water column which showed strong fluorescence (an indication of oil or another substance with similar fluorescent properties), depleted dissolved oxygen, and reduced water clarity (an indication of increased concentration of suspended particles). These layers ranged from depths of 700 m to over 1300 m. Additional CTD casts at sites 2.5 nm and 1.25 nm from the well showed that all three signals (fluorescence, oxygen depletion, and decreased water clarity) increased as the sample sites approached the well. The strongest signals appeared to be southwest of the wellhead. It is important to note that none of these observations establish what caused these signals; oil is only one of many possibilities. Similar results were subsequently obtained by other investigations, and numerous ships have been involved with investigating the location and
extent of subsurface oil (see http://www.restorethegulf.gov/release/2010/10/02/subsurface-oil-monitoring-overview). Much of the data from these investigations are available through the Ship Data page on NOAA’s National Oceanographic Data Center Deepwater Horizon Support Web site (http://www.nodc.noaa.gov/General/DeepwaterHorizon/ships.html).

A working hypothesis to explain these observations is that bacteria are degrading deepwater oil suspensions, and are consuming enough oxygen in the process to cause measurable depletions in the surrounding water. Decreased water clarity may be due to concentrations of bacteria or some particulate matter suspended with or by the oil. Additional information to support or refute this hypothesis will come from analysis of water samples collected at the same sites with CTD rosettes.

This lesson introduces students to techniques that can be used to access and analyze information from CTD studies in the Gulf of Mexico.

**Learning Procedure**

1. To prepare for this lesson:
   (a) Review background information about the Deepwater Horizon blowout and Gulf of Mexico deepwater ecosystems provided in the Educators’ Guide for this Collection.
   (b) Review background information on CTD technology at http://www.pmel.noaa.gov/vents/PlumeStudies/WhatIsACTD/CTDMethods.html; these do not specifically discuss fluorometry, but provide an overview of how CTDs are routinely used in oceanographic research.
   (c) Review questions on the Introduction to CTD Data and How They May Detect Oil Worksheet
   (d) You may also want to consider these additional resources:
       – The background essay, Conservation in the Deep Sea (http://oceanexplorer.noaa.gov/explorations/07mexico/background/conservation/conservation.html), may be used for discussion or student reading.
2. Briefly discuss the Deepwater Horizon blowout, including the following aspects:
   • Recent estimates of the total volume of oil released, how much oil has been recovered, how much has contaminated coastal areas, etc.
   • What strategies and techniques have been used to capture released oil or clean-up contaminated areas;
   • Pros and cons of using dispersants;
   • Effects of spilled oil (this list will probably be long, and should include economic impacts, health impacts, and impacts on natural ecosystems); and
   • Ecosystems that have been affected by spilled oil.

If the latter list does not include deep-sea coral reefs and chemosynthetic communities, briefly introduce these and ask whether students think they might have been affected by spilled oil. The key point here is that although oil rises in water, natural and chemically-induced dispersion can slow the rate of ascent and may form mixtures with other substances that keep the oil near or on the bottom.

3. Briefly describe a CTD. Ask students why oceanographers would want to measure conductivity, temperature, and depth. Be sure students understand the relationship between conductivity and salinity, emphasizing that CTDs are often capable of measuring many other parameters in addition to conductivity, temperature, and depth. You may want to use information and/or images from http://www.pmel.noaa.gov/vents/PlumeStudies/WhatIsACTD/CTDMETHODS.html. Discuss how colored dissolved organic matter (CDOM) can be used to detect oil, and emphasize that many other substances may produce similar results. If necessary, review fluorescence.

4. Tell students that since the Deepwater Horizon wellhead was capped, many ships have been involved in monitoring subsurface oil. Explain that much of the data from these missions, as well as cruises before the well was capped, is available to the public. Say that their assignment is to compare some of these data, and that the techniques they will learn to complete this assignment can be used for many other inquiries that use CTD data.

5. Provide each student group with a copy of the Introduction to CTD Data and How They May Detect Oil worksheet and ensure that students have access to the Web site referenced in Part B, Step 1.

6. When students have answered questions on the Worksheet, lead a discussion of their results. This discussion should include:
• Dissolved oxygen in the ocean comes from photosynthetic organisms that live in the ocean, as well as terrestrial photosynthesizers via oxygen exchange between the ocean and atmosphere.

• The solubility of oxygen in seawater increases as temperature and salinity decrease. So high temperature water can contain less dissolved oxygen than lower temperature water, and water with high salinity can contain less dissolved oxygen than fresh water.

• Dead zones result primarily from algal blooms that may be strengthened by nutrient pollution from large-scale agriculture. When these algae die, their decomposition consumes oxygen. Higher temperatures during the summer also contribute to some extent, since the solubility of oxygen is lower than when temperatures are cooler.

• Students’ plots of Oxygen for CTD casts 70 and 71 should resemble Figures 5 and 6 respectively.

• Plots of data from cast NF70 show that oxygen is highest near the ocean surface where light for photosynthesis is strongest and oxygen exchange between the ocean and atmosphere is at a maximum. Both processes are progressively weaker as depth increases, and a corresponding decline in dissolved oxygen is seen to depths of about 500 m. Respiration of organisms in this depth range may also contribute to lower dissolved oxygen. At deeper depths, oxygen gradually increases as lower temperatures increase the solubility of oxygen. The increase gradually stops around 1500 m and remains more or less constant to the maximum depth of the cast at 2000 m.
• Plots of data from cast NF71 differ from NF70 in that there is an initial increase in dissolved oxygen near the surface, and a small decrease at a depth of about 1150 m. The near-surface increase might be due to a combination of photosynthetic activity and slightly lower temperatures in shallow water as compared to surface water. The “spike down” in deep water is unusual, and is similar to observations made near the Deepwater Horizon wellhead shortly after the blowout.

• Plots of colored dissolved organic matter (CDOM) measurements (column D) from cast NF71 show a sharp increase at the same depth as the dissolved oxygen anomaly. This anomaly is also absent from plots of CDOM from cast NF70. A working hypothesis to explain these observations is that increased CDOM is due to the presence of oil, and that bacteria degrading deepwater oil suspensions are consuming enough oxygen to cause measurable depletions in the surrounding water.

• Be sure students understand that the value of CDOM measurements is that they show where “something” unusual is happening in the water column (i.e., where there are anomalies). Establishing the specific cause of an observed anomaly requires additional data, such as chemical analyses of water samples collected with a CTD rosette.

The Bridge Connection
www.vims.edu/bridge/ – Type “oil” in the “SEARCH” box on the left side of the page for activities and links about ocean oil spills.

The “Me” Connection
Have students write a short essay discussing how understanding the movement of oil from the Deepwater Horizon blowout might be of personal benefit.

Connections to Other Subjects
English/Language Arts, Social Studies, Mathematics

Assessment
Students answers to Worksheet questions and class discussions provide opportunities for assessment.

Extensions
1. See the “Resources” section of Lessons from the Deep: Exploring the Gulf of Mexico’s Deep-Sea Ecosystem Education Materials Collection Educators’ Guide for additional information, activities, and media resources about deepwater ecosystems in the Gulf of Mexico.
2. Visit NOAA’s GeoPlatform Web site (http://www.geoplatform.gov/gulfresponse/) for spill response information, oil spill trajectory, fishery area closures, wildlife data, locations of oiled shoreline and positions of deployed research ships. The Web site also includes a video tutorial.

**Multimedia Discovery Missions**

http://oceanexplorer.noaa.gov/edu/learning/welcome.html Click on the links to Lessons 3, 5, 12, and 13 for interactive information and activities about Deep-Sea Corals; Chemosynthesis and Hydrothermal Vent Life; Food, Water, and Medicine from the Sea; and Ocean Pollution.

**Other Relevant Lesson Plans from NOAA’s Ocean Exploration Program**

- **From the Gulf of Mexico to the Moons of Jupiter (6 pages, 207 KB)**
  http://oceanexplorer.noaa.gov/explorations/02mexico/background/edu/media/gom_moons.pdf
  Focus - Adaptations to unique or “extreme” environments (Earth Science)
  *In this activity, students will be able to explain the process of chemosynthesis, explain the relevance of chemosynthesis to biological communities in the vicinity of cold seeps, and will be able to compare physical conditions in deep-sea “extreme” environments to conditions thought to exist on selected moons of Jupiter. Students will also discuss the relevance of chemosynthetic processes in cold-seep communities to the possibility of life on other planetary bodies.*

- **Biochemistry Detectives (8 pages, 480 K)**
  http://oceanexplorer.noaa.gov/explorations/02mexico/background/edu/media/gom_biochem.pdf
  Focus - Biochemical clues to energy-obtaining strategies (Chemistry)
  *In this activity, students will be able to explain the process of chemosynthesis, explain the relevance of chemosynthesis to biological communities in the vicinity of cold seeps, and describe three energy-obtaining strategies used by organisms in cold-seep communities. Students will also be able to interpret analyses of enzyme activity and $^{13}$C isotope values to draw inferences about energy-obtaining strategies used by organisms in cold-seep communities.*
This Old Tubeworm (10 pages, 484 KB)
http://oceanexplorer.noaa.gov/explorations/07mexico/background/edu/media/old_worm.pdf
Focus - Growth rate and age of species in cold-seep communities (Life Science)
In this activity, students will be able to explain the process of chemosynthesis, explain the relevance of chemosynthesis to biological communities in the vicinity of cold seeps, and construct a graphic interpretation of age-specific growth, given data on incremental growth rates of different-sized individuals of the same species. Students will also be able to estimate the age of an individual of a specific size, given information on age specific growth in individuals of the same species.

C.S.I. on the Deep Reef (Chemotrophic Species Investigations, That Is) (6 pages, 444 KB)
http://oceanexplorer.noaa.gov/explorations/06mexico/background/edu/gom_06_csi.pdf
Focus: Chemotrophic organisms (Life Science/Chemistry)
In this activity, students will describe at least three chemotrophic symbioses known from deep-sea habitats and will identify and explain at least three indicators of chemotrophic nutrition.

Hot Food (4 pages, 372 KB)
http://oceanexplorer.noaa.gov/explorations/03mex/background/edu/media/mexdh_hotfood.pdf
Focus - Energy content of hydrocarbon substrates in chemosynthesis (Chemistry)
In this activity, students will compare and contrast photosynthesis and chemosynthesis as processes that provide energy to biological communities, and given information on the molecular structure of two or more substances, will make inferences about the relative amount of energy that could be provided by the substances. Students will also be able to make inferences about the potential of light hydrocarbons as an energy source for deep-water coral reef communities.

How Does Your (Coral) Garden Grow? (6 pages, 456 KB)
http://oceanexplorer.noaa.gov/explorations/03mex/background/edu/media/mexdh_growth.pdf
Focus - Growth rate estimates based on isotope ratios (Life Science/Chemistry)
In this activity, students will identify and briefly explain two methods for estimating the age of hard corals, learn how oxygen isotope ratios are related to water temperature, and interpret data on oxygen isotope ratios to make inferences about the growth rate of deep-sea corals.
What’s the Difference? (20 pages, 300 kb)
http://oceanexplorer.noaa.gov/explorations/08lophelia/background/edu/media/difference.pdf
Focus - Identification of biological communities from survey data (Life Science)
In this activity, students will be able to calculate a simple similarity coefficient based upon data from biological surveys of different areas, describe similarities between groups of organisms using a dendrogram, and infer conditions that may influence biological communities given information about the groupings of organisms that are found in these communities.

The Big Burp: Where’s the Proof? (5 pages, 364 KB)
http://oceanexplorer.noaa.gov/explorations/07mexico/background/edu/media/burp.pdf
Focus - Potential role of methane hydrates in global warming (Earth Science)
In this activity, students will be able to describe the overall events that occurred during the Cambrian explosion and Paleocene extinction events and will be able to define methane hydrates and hypothesize how these substances could contribute to global warming. Students will also be able to describe and explain evidence to support the hypothesis that methane hydrates contributed to the Cambrian explosion and Paleocene extinction events.

Cool Corals (7 pages, 476k)
http://oceanexplorer.noaa.gov/explorations/07mexico/background/edu/media/corals.pdf
Focus: Biology and ecology of Lophelia corals (Life Science)
In this activity, students will describe the basic morphology of Lophelia corals and explain the significance of these organisms, interpret preliminary observations on the behavior of Lophelia polyps, and infer possible explanations for these observations. Students will also discuss why biological communities associated with Lophelia corals are the focus of major worldwide conservation efforts.

Other Links and Resources
The Web links below are provided for informational purposes only. Links outside of Ocean Explorer have been checked at the time of this page’s publication, but the linking sites may become outdated or non-operational over time.

http://oceanexplorer.noaa.gov/ – Ocean Explorer Web site
http://www.piersystem.com/go/site/2931/ – Main Unified Command Deepwater Horizon response site

http://response.restoration.noaa.gov/deepwaterhorizon – NOAA Web site on Deepwater Horizon Oil Spill Response

http://docs.lib.noaa.gov/noaa_documents/NESDIS/NODC/LISD/Central_Library/current_references/current_references_2010_2.pdf – Resources on Oil Spills, Response, and Restoration: a Selected Bibliography; document from NOAA Central Library to aid those seeking information concerning the Deepwater Horizon oil spill disaster in the Gulf of Mexico and information on previous spills and associated remedial actions; includes media products (Web, video, printed and online documents) selected from resources available via the online NOAA Library and Information Network Catalog (NOAALINC)

http://www.gulfallianceeducation.org/ – Extensive list of publications and other resources from the Gulf of Mexico Alliance; click “Gulf States Information & Contacts for BP Oil Spill” to download the Word document

http://www.darrp.noaa.gov/southeast/deepwater_horizon/index.html – Information about damage assessments being conducted by NOAA’s Damage Assessment Remediation and Restoration Program

http://response.restoration.noaa.gov/ – Click “Students and Teachers” in the column on the left for information, fact sheets, and activities about oil emergencies, habitats, and other ocean issues

http://www.noaa.gov/sciencemissions/bpoilspill.html – Web page with links to NOAA Science Missions & Data relevant to the Deepwater Horizon/BP Oil Spill

http://ecowatch.ncddc.noaa.gov/jag/data.html – Data Links page on the Deepwater Horizon Oil Spill Joint Analysis Group Web site

http://ecowatch.ncddc.noaa.gov/jag/reports.html – Reports page on the Deepwater Horizon Oil Spill Joint Analysis Group Web site

http://www.education.noaa.gov/Ocean_and_Coasts/Oil_Spill.html - “Gulf Oil Spill” Web page from NOAA Office of Education with links to multimedia resources, lessons & activities, data, and background information

http://www.geoplatform.gov/gulfresponse/ - Web page for GeoPlatform.gov/gulfresponse—an online map-based tool


Shafir, S., Van Rijn, J., and Rinkevich, B. 2007. Short and long term toxicity of crude oil and oil dispersants to two representative coral


**National Science Education Standards**

**Content Standard A: Science As Inquiry**
- Abilities necessary to do scientific inquiry
- Understanding about scientific inquiry

**Content Standard B: Physical Science**
- Chemical reactions
- Motions and forces

**Content Standard D: Earth and Space Science**
- Energy in the Earth system
- Geochemical cycles

**Content Standard E: Science and Technology**
- Abilities of technological design

**Content Standard F: Science in Personal and Social Perspectives**
- Natural resources
- Environmental quality
- Natural and human-induced hazards
- Science and technology in local, national, and global challenges

**Content Standard G: History and Nature of Science**
- Nature of scientific knowledge

**Ocean Literacy Essential Principles and Fundamental Concepts**

**Essential Principle 1.**
The Earth has one big ocean with many features.

**Fundamental Concept h.** Although the ocean is large, it is finite and resources are limited.

**Essential Principle 3.**
The ocean is a major influence on weather and climate.

**Fundamental Concept f.** The ocean has had, and will continue to have, a significant influence on climate change by absorbing, storing, and moving heat, carbon and water.
Essential Principle 5.
The ocean supports a great diversity of life and ecosystems.
Fundamental Concept c. Some major groups are found exclusively in the ocean. The diversity of major groups of organisms is much greater in the ocean than on land.
Fundamental Concept d. Ocean biology provides many unique examples of life cycles, adaptations and important relationships among organisms (such as symbiosis, predator-prey dynamics and energy transfer) that do not occur on land.
Fundamental Concept g. There are deep-ocean ecosystems that are independent of energy from sunlight and photosynthetic organisms. Hydrothermal vents, submarine hot springs, and methane cold seeps rely only on chemical energy and chemosynthetic organisms to support life.

Essential Principle 6.
The ocean and humans are inextricably interconnected.
Fundamental Concept b. From the ocean we get foods, medicines, and mineral and energy resources. In addition, it provides jobs, supports our nation’s economy, serves as a highway for transportation of goods and people, and plays a role in national security.
Fundamental Concept g. Everyone is responsible for caring for the ocean. The ocean sustains life on Earth and humans must live in ways that sustain the ocean. Individual and collective actions are needed to effectively manage ocean resources for all.

Essential Principle 7.
The ocean is largely unexplored.
Fundamental Concept a. The ocean is the last and largest unexplored place on Earth—less than 5% of it has been explored. This is the great frontier for the next generation’s explorers and researchers, where they will find great opportunities for inquiry and investigation.
Fundamental Concept b. Understanding the ocean is more than a matter of curiosity. Exploration, inquiry and study are required to better understand ocean systems and processes.
Fundamental Concept d. New technologies, sensors and tools are expanding our ability to explore the ocean. Ocean scientists are relying more and more on satellites, drifters, buoys, subsea observatories and unmanned submersibles.
Fundamental Concept f. Ocean exploration is truly interdisciplinary. It requires close collaboration among biologists, chemists, climatologists, computer programmers, engineers, geologists, meteorologists, and physicists, and new ways of thinking.
Send Us Your Feedback
We value your feedback on this lesson.
Please e-mail your comments to: oceanexeducation@noaa.gov

For More Information
Paula Keener, Director, Education Programs
NOAA's Office of Ocean Exploration and Research
Hollings Marine Laboratory
331 Fort Johnson Road, Charleston SC 29412
843.762.8818  843.762.8737 (fax)  paula.keener-chavis@noaa.gov

Acknowledgements
This lesson was developed by Mel Goodwin, PhD, Marine Biologist and Science Writer. Design/layout by Coastal Images Graphic Design, Mount Pleasant, SC. If reproducing this lesson, please cite NOAA as the source, and provide the following URL: http://oceanexplorer.noaa.gov/
Introduction to CTD Data and How They May Detect Oil Worksheet

Part A: Background
1. Where does dissolved oxygen in the ocean come from?

2. How do temperature and salinity affect dissolved oxygen?

3. In some areas of the Gulf of Mexico, dissolved oxygen often is very low during the summer, resulting in “dead zones.” What causes this depletion of dissolved oxygen?

Part B: Analyze!
1. Download a CTD Data File
   a. Open the Ship Data page on NOAA’s National Oceanographic Data Center Deepwater Horizon Support Web site at http://www.nodc.noaa.gov/General/DeepwaterHorizon/ships.html. In the Ship List on the left side of the page, click Nancy Foster. Now you see a summary of data collected aboard NOAA Ship Nancy Foster as part of the response to the Deepwater Horizon blowout. The map on the right shows the ship’s track during the cruise which lasted from July 1 - July 18, 2010. Under Subsurface Oil Monitoring Data, click Processed next to Cruise 01.
   b. A new window opens titled Index of DeepwaterHorizon/Ship/Nancy_Foster/ORR/Cruise_01/processed. Click ctd/.
   c. A new window opens containing separate folders for each CTD cast during Cruise 01. Click on the folder named 2010_0717_NF70/. This folder contains nine files that contain data from CTD cast #70 aboard the Nancy Foster on July 17, 2010 (now you know what the folder name means!).
   d. Click on the file named NF1013_070_edit_bin_avg.asc. Now you have a window full of data! To work with all these numbers, we need to import them into a spreadsheet such as Microsoft Excel®. Right click (control-click on a Macintosh platform) in the window containing the data and save the page as an ASCII text file. Name the file NF70.txt.

2. Import the file into a spreadsheet
   The following instructions are for Microsoft Excel® 2008. Other versions of Excel or other spreadsheets will require slightly different procedures. See user documentation for how to import text files and make graphs from these files.
   a. Launch Microsoft Excel® and choose Import... from the File menu.
   b. Click the button next to Text file, then click Import. Navigate to your file named NF70.txt then click Get Data.
   c. A window named Text Import Wizard - Step 1 of 3 will open. Be sure the button next to Fixed width is checked, and the Start import at row box is set to 1. Then click Next.
d. Now the Text Import Wizard - Step 2 of 3 window shows a preview of how your data will appear in the spreadsheet. No adjustments should be needed, so click Next.

e. Be sure Column data format is set to General then click Finish. Check the button next to New sheet then click OK. Now you should have a spreadsheet containing the CTD data from cast #70. Before you do anything else, save your spreadsheet!

3. What do the numbers mean?
The first row of the spreadsheet identifies the type of data in each column.
The abbreviations are:
Column A: T090C – Temperature measurement in degrees C
Column B: PrDM – Pressure measurement in decibars
Column C: Sbeox0V – Actual voltage from the dissolved oxygen sensor (this is converted to normal units for dissolved oxygen and the values are listed in columns N and O)
Column D: WetCDOM – Fluorescence measurement from the colored dissolved organic matter sensor
Column E: FIECO-AFL – Fluorescence measurement from the chlorophyll sensor
Columns F, G, H: V1, V2, V3 – Voltage measurements from other sensors; in this case V1 is the same as Column E, V2 is the same as Column C, and V3 is not used
Column I: C0S/m – Conductivity measurement in Siemens per meter
Column J: DepSM – Depth in meters
Column K: Sal00 – Salinity in Practical Salinity Units
Column L: Density00 – Density in kg per cubic meter
Column M: SvCM – Sound velocity in meters per second
Column N Sbeox0Mg/L – Dissolved oxygen in mg/l
Column O: Sbeox0ML/L – Dissolved oxygen in ml/l
Column P: Flag – Used to identify measurements that may not be valid
Many more details of this CTD cast are contained in the file NF1013_070_edit_bin_avg.hdr, including the latitude and longitude of the cast location.

4. Analyze the data
Plot Oxygen as a function of Depth:
a. Select Columns J and N.
b. Under the Insert menu select Chart...
   A pop-up menu will appear.
c. In the popup menu, click on the XY (Scatter) tab.
d. Click on the Smooth Lined Scatter button. Now you should have a graph that resembles Figure 1.
5. Oceanographers like to plot CTD data with depth on the y-axis and the greatest depths at the bottom of the plot, since that is the way we usually think about a profile of the water column. For an x-y plot, Excel plots the first column on the x-axis. So, to make an “oceanographer’s plot” we need to re-arrange the data so that temperature values come before depth values.

a. Copy the depth column to one of the blank columns on the right side of the spreadsheet.
b. Select the Column J and the new Depth column on the right.
c. Click on the **Smooth Lined Scatter** button (the **XY (Scatter)** tab should still be selected). Now you should have a graph that resembles Figure 2.

d. To make the greatest depths appear at the bottom of the plot, double click on the y-axis. The **Format Axis** window will appear. Click the **Scale** button on the left side of the window, then check the **Values in Reverse Order** box, then click **OK**. Now your graph should resemble Figure 3.

e. We need to make four more changes. First, the x-axis is now at the top of the plot. To fix that, double click the y-axis again and check the **Horizontal (category) axis crosses at maximum value** box. Then click **OK**. Next, the title of the graph needs changing: Click on the title, then highlight the text. Type in **Oxygen**. Now remove the legend on the right side of the graph by clicking on the legend and hitting the **Delete** key. Finally,
let’s add labels to the x- and y-axes: Click inside the plot area, then drag one of the handles on the left side of the plot toward the center to make space for a label on the y-axis. Make the Drawing toolbar visible (select from Toolbars in the View menu), and select the text tool. Click on the left side of the plot and type Depth (m). Format the text with tools in the Formatting toolbar (select from Toolbars in the View menu), then drag the green handle on the text box to rotate the text 90 degrees. Right-click (control click on a Macintosh platform) and drag the text box to the desired location. Use the same procedures to label the x-axis Dissolved Oxygen (mg/l). Now your graph should resemble Figure 4.

Figure 4

![Cast 70 - Oxygen](image)

6. According to your plot, how does dissolved oxygen vary with depth? What factors or processes might explain these results?

7. Compare with another CTD cast.
   Follow procedures in Step 1 to download data from CTD cast 2010_0717_NF71. Follow procedures in Steps 2 and 5 to plot Oxygen as a function of Depth. How does your graph from cast 2010_0717_NF71 compare with your graph from cast 2010_0717_NF70? What factors or processes might explain these results?
8. Table 1 shows a list of sites scheduled to be investigated during the Lophelia II 2010: Cold Seeps and Deep Reefs Expedition. The Deepwater Horizon wellhead is located at 28.7366° North latitude, 88.3872° West longitude. Which of these sites is closest to the blowout location? Could this site be affected by an oceanographic phenomenon similar to the one that appears in data from NF71?

Table 1: Sites to be Investigated during Lophelia II 2010.

<table>
<thead>
<tr>
<th>Site</th>
<th>Depth (m)</th>
<th>North Latitude</th>
<th>West Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT047</td>
<td>835</td>
<td>27.8802</td>
<td>-89.7888</td>
</tr>
<tr>
<td>GB535</td>
<td>585</td>
<td>27.4274</td>
<td>-93.5854</td>
</tr>
<tr>
<td>GB299</td>
<td>300</td>
<td>27.6865</td>
<td>-92.2296</td>
</tr>
<tr>
<td>GC184</td>
<td>525</td>
<td>27.7493</td>
<td>-91.5077</td>
</tr>
<tr>
<td>GC140</td>
<td>300</td>
<td>27.8103</td>
<td>-91.53768</td>
</tr>
<tr>
<td>GC852</td>
<td>1422</td>
<td>27.1101</td>
<td>-91.166</td>
</tr>
<tr>
<td>GC249</td>
<td>790</td>
<td>27.724</td>
<td>-90.5149</td>
</tr>
<tr>
<td>MC294</td>
<td>1350</td>
<td>28.6758</td>
<td>-88.4788</td>
</tr>
<tr>
<td>MC165</td>
<td>1235</td>
<td>28.8347</td>
<td>-88.3222</td>
</tr>
<tr>
<td>MC751</td>
<td>438</td>
<td>28.1937</td>
<td>-89.7987</td>
</tr>
<tr>
<td>MC885</td>
<td>650</td>
<td>28.0646</td>
<td>-89.6951</td>
</tr>
<tr>
<td>VK906</td>
<td>377</td>
<td>29.0696</td>
<td>-88.3772</td>
</tr>
<tr>
<td>VK826</td>
<td>460</td>
<td>29.1564</td>
<td>-88.01503</td>
</tr>
</tbody>
</table>